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Soft-GRAF Studio : Create a Colorful HMI in the XP-8xx7-CE6 & WP-8xx7 &
VP-2xW7 PAC

Soft-GRAF, an HMI software developed by ICP DAS, allows user to create his colorful
HMI application running with the control logic in the same PAC. Using the PAC with
the Soft-GRAF support, user can easily edit its HMI screen by Soft-GRAF Studio and
design the control logic by ISaGRAF software.

There are three types of HMI Objects in the Soft-GRAF Studio:

"Label/Value", "Button/Input", "Drawing"

User can create the HMI object directly by using the mouse to drag and drop the Object into the
editing screen and set the properties by mouse/keyboard to achieve different display.
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1.1 : Soft-GRAF Studio Version and Installation

Soft-GRAF Studio Installation:
The Soft-GRAF Studio is version 1.01 now. Please get the document (faq146) and

demo programs from the following folder of CD-ROM in your PAC package.
CD-ROM: \napdos\soft-graf\
Or download it from the following website.

www.icpdas.com > FAQ > Software > ISaGRAF > 146
http://www.icpdas.com/fag/isagraf.htm > 146

Other related information:
ISaGRAF User’s Manual
http://www.icpdas.com/products/PAC/i-8000/getting started manual.htm

Soft-GRAF Studio, the software to edit the Soft-GRAF HMI, can run in the PC with
the WinXP, Win Vista, Win7 or compatible Operating System and the .Net
Framework V.3.5 or later version. The current version is 1.01. The execution
program is included in the downloaded FAQ-146 zip file. After unzip the file, please
copy the “"Soft-GRAF Studio” folder into “D:\". The “Soft-GRAF Studio” folder
must include the following files (as below picture).
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’J Demo03 //{ Demold
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- B demal pin
LoginDemo R EE
- 123 KB
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Adobe Acrobat Document KL 3
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Soft-GRAF Studio exe
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PAC Driver:
The following ISaGRAF driver versions support Soft-GRAF Studio:
PAC Model ISaGRAF Driver Version
WP-8xx7 Ver.1.39 or later
VP-25W7/23W7 Ver.1.31 or later
XP-8xx7-CE6 Ver.1.19 or later

If your PAC’s ISaGRAF driver version is later than the version listed above, it
supports the Soft-GRAF Studio.

However if its version is older, please visit the following web site to download the latest
ISaGRAF driver into your PAC.
http://www.icpdas.com/products/PAC/i-8000/isagraf-link.htm

After downloading, update the driver into the correct model of PAC. Please click on “End Driver”
button in the “ISaGRAF driver” window of the PAC’s VGA screen to end the ISaGRAF driver first,
then unzip the downloaded file and copy all files and the sub-directory in the related version-
number directory to the “\System_Disk\ISaGRAF\” path in your PAC via FTP or USB disk.

For instance, to update the ISaGRAF driver of XP-8xx7-CE6 to Version 1.19, please
click on the “End Driver” button in the “ISaGRAF driver” window of PAC, then unzip the
downloaded file “xp-8xx7-ce6-1.19.zip"” and copy all files and the sub-directory “sofgrafy”
in the "1.19"” directory to the “\System_Disk\ISaGRAF\” path in the XP-8xx7-CE6. And then,
reboot the XP-8xx7-CE6. Now, the driver of the PAC is updated.

WInPAG-8x47[Bx46/8x37/8x36 1SaGRAF Driver oK)
Setting | weh | About

Configuration

Slave Mumber |1
Madbus RTU Slave Port INone

Baud Rate |19200 |JNJ &, 1

Project
Current Application Idem004, ISA11=1384, ISA12=916 Delete

Elapsed Time |D:D: 12:36 End Driver
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Next, retore the file “sofgrafy.uia” that downloaded/unziped from the FAQ-146 of
“faql146_chinese_demo.zip” into the “c functions” of the PC ISaGRAF, as below :

é ISaGRAF - Project Management - imi vl
2 S g S
Fle Edit Project l‘lools St Ha # ISaGRAF - Libraries = ]I:II

| & Aschive File Edit Tools Options Help

— T — C functions >l Dm‘%|ﬁ
[ sofgr 00 IO configurations N
sofgr_01 ImportIL p JO complex equipments S
Reference 150 ¢ boatdls jet
Author - fpone het 1: XP-8xx7-CEB
z JFunction block: . x
Date of creation : 2010/8/6 e
fll % 1SaGRAF - Libraries i fu]] 51'
File Edit | T Options  Hel;
Hene _ols el Archive - C functions . 5]
I C function: LU
s fl ini Siandardwgonnat Wor<bench Archive
' N s_mb_ad fsofgrafy T i
s_fl_rst ICP DAS , e = 2 Backup
SIS N2 integmtion st
s_m_r i gri o & |snw Restore
S_m_w = S Ir
s_mb_adr Please refer to one [S_I_W Close
s mv - s_wd_r
s wd_w
sn';s_gets
sms_send . [V Compress
— Archive location
DACHUN_DASOFGRAFY Browse

And also, restore “soft-grf.xia” into the “I0 complex equipments”of the PC ISaGRAF.

A I3aGRAF - Project Managemen = aal = =

Ele B Do I—L:u:uls Unimms ek -'. ISaGLF— L1hra.tes ;lgl
|l'_‘| Lrchive b |%Eﬂ3 Edit Tool: Optons ﬂg.m”.% |

—M IC complex equipments | ] B (5
m 10 W i configurations R

hmi_01 Imnport IL program Nfto IC complex: equipments

PTRrFrEOMA - n - |Ob d
__IS e L_h e ) fak I-7000 & 87K remote IO
FETTT e —— —
File Edit | Tools Options Help
| YWwiorkbench Archive
bz 7000 o E i Backuy |
h 00 Standard note format b 7000h = L
us b 7000
3 —
bus7000: 1CF DA? _ 87| |can?B30 Hestore s, |
T =2 mteg;f&tmn g ebuz m
canfhil —
ehuc m _-:I ebus_s Cloze |
ebus_s2
eth_tcp
eth_udp Help |
i_F183ug
i 3017a i v Compress
—&rchive location
CoACHUM_DMNSOFT-G14 Browze ﬂ
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The HMI objects below are supported by Soft-GRAF driver (since Ver.1.09):

Label/Value Type :

1 | g_Label Display a Label

2 |g_B_Vval Display a Text to show a Boolean value

3 | g_WD_Val | Display a 16-bit integer (occupy 1 Network addr. number)

4 | g_N_Val Display a 32-bit integer (occupy 2 Network addr. numbers)

5 |g_F_Val Display a 32-bit Float value (occupy 2 Network addr. numbers)
6 | g_N_Text | Display a text to show an Integer value

Button/Input Type :

1 |g_B_inp Create a button to input a Boolean value
2 | g_WD_inp | Create a button to input a 16-bit integer value
(Occupy 1 Network addr.)
3 |g_F_inp Create a button to input a 32-bit Float value
(occupy 2 Network addr. numbers)
4 | g_N_inp Create a button to input a 32-bit integer value
(occupy 2 Network addr. numbers)
5 | g_Login Create a Login button with password
6 | g_Logout | Create a Logout button
7 | g_ToPage | Create a switch-page button
Drawing Type :
1 | g_B_lLed | Display a LED to show a Boolean value
2 | g_B_Pic | Display a picture (JPG, PNG, GIF, BMP) to show a Boolean value
3 | g_N_Pic | Display a picture (JPG, PNG, GIF, BMP) to show an Integer value
4 | g_Trace2 | Display a 2-axes (x , y) or 1-axis (x : Horizontal) or 1-axis (y :
Vertical) moving trace map
5 | g_Rect Draw a Rectangle
6 | g_Bar Display one value as a bar-meter
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1.2 : Edit the HMI by the Soft-GRAF Studio software

To test Soft-GRAF Studio demo projects, please refer to Ch.1.7.1 and the description

for demo4 and "My Sweet Home”demo in Ch.1.7.2.
To execute the Soft-GRAF Studio, please double click the “D:\ Soft-GRAF Studio\Soft-

GRAF Studio.exe”. If "Soft-GRAF Studio.exe” doesn‘t found, please refer to Ch.1.1 to install it.

The software operating environment :

Soft GRAF HMI Editor

I'Fﬂa CRED T For basic file operating, password
e o o T 1 N e . X .
i setting, upload IP configuration.

\ 4

HMI Tool Bar

\ 4

HMI Page Editing Area

Display and switch the project HMI pages

\ 4

One Soft-GRAF project can contain maximum 200 HMI pages (No. 1 to 200). The
PAC will display the Page No. 1 if it has enabled the Soft-GRAF in the program when
powering it up. Every Page is displayed as full screen and only one Page is shown
on the VGA monitor, so user must set up the VGA resolution when create a new

project.

The PAC Resolution:

PAC Support VGA Resolution
XPAC 640*480, 800*600, 1024*768
WinPAC 640*480, 800*600
VP-25W7 640*480
VP-23W7 320*240
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Soft-GRAF Studio offers two ways to use the manual to query the functures. Click
the menu bar “Help” > “"Dociment” or in a project right click on the HMI editing area
then select “Help”. —_—

File  Project | Help
j - H | Diocument | ljl

Project View About [K=3 o

Page 1

Hel
[ " ]

The origin of Soft-GRAF Studio axis, in the Soft-GRAF Studio editing screen, is at the
top left of the axis position as follows:

(0,0) X

Y
The horizontal axis of the monitor is called "X axis”, while vertical axis is called Y
axis”. The original position of (X, Y) is (0, 0) which resides at the most top-left
position on the monitor. The value of X coordinate is increasing from left to right
direction. The value of Y coordinate is increasing from top to bottom direction. The
unit of the (X , Y) coordinate is "Pixel” . For example, the default resolution setting
of the WP-8847 is 800 x 600, so its X coordinate ranges from 0 to 799, while ranges
from 0 to 599 for Y coordinate; The default resolution setting of the VP-25W7 is 640
x 480, so its X coordinate ranges from 0 to 639, while ranges from 0 to 479 for Y
coordinate.

1.2.1: Edit a simple Soft-GRAF HMI
The following picture is the VGA Screen view when run "Demo01”:

Soft-GRAF DemoO1

| | | OM = 5 sec —>OFF

Goto Page 2
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Before editing HMI page, ISaGRAF must have the following setting. If you are not
familiar with ISaGRAF programming, please refer to the Ch1.1, Ch1.2 and Ch2 of
“ISaGRAF Advanced User Manual”. The manual website is as below:
http://www.icpdas.com/products/PAC/i-8000/getting_started_manual.htm

Open your project (or create a new one, ex: demo01), click the “I/O
Connection™ tool icon of the programs window.

File IMake Project Tool: Debug Optons Help

B ESE DE 0| = X m
~

Set “soft_grf” to the “Slot” and the slot humber must after “"8” inorder not to conflict
with the real I/O using slots of PAC.

7]
&
o | mm soft_grf w
[-] = Setting S

Select board fequipment E

i_Bkdpi: [-7000 10z on Com3 or COkK4 -
i8ke: Link 1-8KE4-MTCP or -8KES-MTCF
key_init: Set keypad features

led_imit: Set LCD features LCancel
mbuz Modbuz BTU master
mbuz_azc: Modbus ASCI master Mote
mbus_tep: Modbus TCPAP master [FAGQ-11
mmicor: Connect MMICOM by Com3 or Con
modem_ps: Set Pazsword of Comd: Moden_

u;

rdr: Redundant Systern [For Wincon) Library
rdn_new: New Redundant System [w-Sxd7

ttu_slaw: 2nd ~ Bth Modbuz RTU slave port— "~ Boards
rtu_slv? B ™ 9tk Modbus RTU slave port =
$206_512: Battery backup SRAM for |-8xx7 i+ Equipmerts
smg Short Message Service -

‘=zoft_ qrf: enable t

Then, create a new LD Ladder program in the project.

‘
File Make Project Tool: Debug Opton: Help E—————  —

E%H|m\m|$mi¢|m I arne: |test |

Carnmnent: |fo fag1 46 |

Language; | Guick LD : Ladder Diagram ﬂ|

Create new program

Style: | Begin: Main program ﬂ|

k. \ Cancel |

\

B | HSIX DhE M X

Begin: [Ta) te st Qg ErE

), ,
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Add one Boolean variable "LED_01" into the Dictionary of the ISaGRAF project and
set its address as 11 (key in the Hex. number: “B”).

File Make Project Tool: Debwg Ophion: Help

BB S DEM XK o

Boolean Yariable n
I arme; LED 01 | Metwaork Address:  |000E w
N\, ~——_ h
Comment:  [Netw addr. = S Here enter the Hex.
_ Number “B”, that is
Altributes Walues 11 in decimal.
I+ |nternal Falze: | |
O |nput Cancel
~ ) True; | |
Cutput Nest
I Caonztant [ et to tue at init
[ Retain Breviousz
File Edit RGeS Option:  Help

@O0e | cexmd e

Booleans ]Integers.lﬂeals | Timets | Meszages | FB instances | Defined waords |
rlame Bitri

After finishing ISaGRAF SoftLogic, You must compile and download the ISaGRAF
project into your PAC (Refer to Ch.2 of ISaGRAF Advanced manual for the steps.),
then can design the HMI.

Run Soft-GRAF Studio to edit the HMI. First, create a project (*.sof) as below.
Click “File” > “"New"” of menu bar or click "Create New File" tool icon.

Soft GRAF HMI Editox

T Do [ Soft GRAF HMI Editor
T u
] Oew\\‘ B M O
pen — —
HE ) R E W Am W N b
, S~

Save

Exit {Create New File [
| LabelValue v| ‘ ‘
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Give a project name and file location.

New File Setting El

Project Name
|Projeci£l I

Project name

Location
|c Documents and Settingsmseridy Documentsi¥ imal Stodio | E]

y

Project file location

PAC Select

EPAC v|  [1024 * 768 v|——1» | PAC & VGA resolution

[ Create ][ Cancel ]

To open a file: Click “File” > “Open” of menu bar.

Soft GRAF HMI Editor

File | Project  Help

Soft GRAF HMI Editor
WNew M
Cpen \ File  Project Help
Have 1H1|é6]"|—|_—|

= 1 |

Change the directory to find the project (*.sof) in the File Dialog.

BH(©: | () Demol ~ o2 mE

— [)Fic

e w\
i it pleat
@

S

FADa
Fa=EhE

.

b LHSHE a4 2 |Dem01 sof w | [ BRSO} Kl
N
BIABAT: [ SoftGref files (%s0f) v By N
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Now create a HMI page. The following HMI is the same as the Demo01, please set
all the Network address in this project as 11 (the address is the same as the
Boolean variable "LED_01" in ISaGRAF program).

First, create a “g_Label” object. Drag & drop “g_Label" object into the editing area.

Project View

Page 1

LabelValue “

g_Label

g B_val \E
|

g WD _val

=]

g F wal
g N wval

2 N_Text

IIIII’

Mouse right clicks on the Object and selects the “Setting”.

T = » Click the mouse left key on here
|} SthIl,g K
Dielete \\
Cut
Copy

Click “Font size” to set up as “10,Bold”.

£ Label ﬁ'
Common
Net Waork Address size Wizon | H |60
Font size Location X [yp2 |¥ (51
Fore Color E] Text Aign | apter “
Back Color :] Tifle Hoft-GRe
| ok || Comel |
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TR o

HiE 10 | fEE ‘{

el
[ A48 0
(&S th3r 7R
FHRE:
| CHINESE_EI5 v/

Set up the Object Size as W:300 and H:60.

(oo |
Net Work Address I:I Size W H
Font size Location X '
Fore Color E] Text Align
Back Color :] Title

Or using the mouse left key to change the Object size.

\ 4

Use the mouse left key to resize

f
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Next, set up the title of "g_Label” Object for the text displayed on the object.
Double click the text box of the “Title” and key in “Soft-GRAF Demo 01", then click
“Accept” button to close the window, and click “ok” to end the setup.

Double click on the box

Key in “Soft-GRAF Demo 01"

Cormimon |
Net Work Addres I:l Size W H
Font size 0, Regular Location X ¥
Fore Color E Text Align
Back Color E Title
EditMassStringFrm X
|
£ Label E
Common |
Net Work Lddres I:l Size W H
Font size Location X ¥
Fore Color E] Text Alipn
Back Color :] Title

| Ok ‘J[ Cancel |
N
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Next, create a “g_B_Led"” object. Drag & drop a “g_B_Led"” object to the editing area,
mouse right key click on the object and select “setting” to configure the following
setting, such as, Network address: 11, Size W: 40, Size H: 40, Font: 10,Bold, Shape:

Circle.

Project View
Page 1

Diraweing w

S0f-GRAF Demo 01

Setting
Delete \

Cut
Copy
z B Led E|
Led stting
T R = »| Set to show different
message when False
: . True Falze Message when True| [og and True.
nput T color || (N Shape
Size W(ag H [4p Font 12,Bal
Locaton X [1np ¥ 129
[ Ok K][ Canel
N\

N
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Drag & drop a “g_B_Pic” object to the editing area.

Page 1

Dirawing w

g B Led

g B_Fic
g N_Pic Soft-GRAF Demo 01

>< ]

a =]

II}I

&_Traced

@

Right key click and select the “setting”.

P
Setting

Delete S~

Cut

Copy

Set up the picture of “True File” for “True”. The picture can be “.gif” dynamic image
format. The demo picture can be got from the “//Picture//gif” directory of the demo
file “faq146_chinese_demo.zip" (Refer to Ch.1.5 for more about the dynamic image
format).

Net Work Address [
wize Wiza  |H 128

Location X (211 Y |57

Tme File [ Wo_Pic \]

Falze File [ Ha Fic ]
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Select “"Fan03-m-(041).gif” file and click Open(Q).
EE RIX]
BHD | O =it v & & @
»| Battery0l-m-{020).gif  |™)BatteryDd-s-(0500.gif | ® ) Fan04-m- (0607 gif -
) L]
i =) Batterylll-m-(021) gif %] Battery0d-s- (0510 it [™] FanDd-m- 161} zif =
HBESERE | M Batery0l-s-020).gif %) Fandl-m-030).gif %] Fan4-s- (060). gif =
- %) Batteryl-s-(021) gif %] Fanil1-m- 0313 gif %] Fan04-s- (061) gif =
F %) Battery02-m-(050) gif  [%] FanDL-s-(030) gif (] Pluid01-im- (040) gif =
e ™) Battery02-m-[051).gif %] Fanll-s-{031).gif (%] Floid01-m- 041 gif =
™) Battery(12-s-(050) gif | FamiT2-m- 1407 gif (=] Fluid1-5- (0401} git =
™| Battery02-s-051).gif %] FanlZ-m-(041).gif (%] Fluid01-s- (041 gif =
%) Battery13-m-(130) gif %] Fani12-5-(0407 gif %] Fluid02-m- (070 gif =
A ™ Battery03-m-031).gif W] Fand2-s-(041) gif (%] Floid02-m-071). gif 5
%) Battery03-s-030).gif %] Fanl3-m- (0407 gif %] Fluid02-s- (070, gif w
':'J ] Battery03-5- (031} gif Fanll3-m- (0413, # | ™) Fluid02-5- (071 ). gif =
SRR %] Battery0d-m-[050).gif %] Fanl3-5-(040). gif ) Fluid 0 3-m-(050).gif =
_ %) Battery4-m-[151) gif %] Fanfl3-5-(041} gif %] Fluid03-m- 51} gif =
< | >
LIS e . Fan3-m- (041} if v| FARIQ)
WHRIERND: | oif Fles(*gif) v i T~

Set “False File” as “Fan03-m-(040).gif”. Then, set "Net Work Address” as 11, and

click “ok” to exit.

Met Work Lddress
Location X Y

True File [ Fand3-m-(041) gif w|
Fele File |

No_Pic |

Ok ][ Cancsl
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g PIX
B | O aif v Q% m-
Y ,:] Batter1-m- (0200 zif ,:] Batteryild-z-(050) gif ,:] Fan04-m-{060) gif ,::
%] Battery01-m-(021).gif %] Battery04-s-(051).gif %] FanDd-m-{061) gif &
RIS | |2 Batery0l-s-020).gif (%] FanDl-m- (130).gif (] Fan04-5-(D60).gif &l
. ,ﬂ Battery1-s- (0210 2af ,:] Fanl1-m- {031} zif ,ﬂ Fan04-5-{061). gif ,::
@ ,ﬂ Battery12-m-{050). gif ,:] Fan01-s- (030} gif ,ﬂ Fluid01-m-{040% gif ,i
e %] Battery02-m-(051).gif ) Fand1-s-{031) gif %) Fluid0l-m-(041) gt [
%] Battery02-- (0503 gif W) Fan0Z-m- (040} gif %] Fluid01-5- (040} gif S
: %) Battery02-5- (051) gif W] FonlZ-m-(041). gif %) Flnid01-& (041). gif =
%] Battery03-m-(030).gif | ) FenZ-o- (0407 gif %) Fluid02-m- (0700 gt W
AT %) Battery03-m-(031).gif ) FanlZ-s-(041) gif %) Fluid02-m- (0713 git i
— ) Battery03-5- (030 it (S ITIERTRUEIEN [*) Flnid02-5 (070). if &
:ﬁﬂ %] Battery03-5- (0213 2if %] Fem3-m- (0411 (%] Fluid02-s- (071} git S
AR ,ﬂ Battery14-m-{050). gif ,:] Fan(3-s- (040) gif ,ﬂ Fluid03-m-§150% gif ,::
%) Battery(4-m-(051).gif %] Famil3-s- (141 gif %) Fluid03-m-051) gt (%]
‘..} < ¥
‘-"-J-'-o—
S LADSHE e oy Fan3-m-{040).gif v
WIRERTY: [ gif Fles(* gif) v mE N
Wet Work Address  [1q
Hize W4 H g4
Location X |50 T |og
Troe File [ Fan03-m-(041).gif |
Fale File [ Fan3-m-(040) gif |

Next, create 2 “"g_B_Inp” objects. Drag & drop a “g_B_Inp” object into the editing

area.

ButtonTnput

g B Inp

2 WD _Inp

g F Inp

£ N Inp

g Login

£ Logout

g ToPage

Fage 1

Soft-GRAF Demod1

M --= 5§ sec --=0FF
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Mouse right key click and select “Setting”, then set "Net Work Address” as 11, “Font
Size” as "9,Bold” and set the same “Input color” for True and False.

[ w3 I Oh
o NSetting
Goto R Delete N
Cut
Copy

.........................

.........................

Met Work fddress |11 size  Wi7g |H |25

Font #ze Location X [go |¥ (120

True Fale=
Input T/F color [ ] [

[] &ppearance

| ok || Comeel |

Switch to the “Input Setting” page, key in *"ON/OFF” in the Textbox of “"Show as
string”, and click “Ok”.

common |; Input Settne |

{3 Ehow as picture

(%) Show az string |ON / OFF Switching Time I:Isec.

() Show as value Level

Boolean Fals I:I [] Ask before operation
R .

Mode Belect  |[Wommal o

[0 g [ ol ]
™~
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Then create another “g_Inp” object. Right click and select "Setting” to set the “"Net

work address” as 11, “Font Size” as “9,Bold” and set the same “Input color” for True
and False.

L ON --> 5 sec -->0FF
""""" Setting \

] Delets ~

Cut

Copy

|
I
Tt
=
X

Wet Work Address {1 Gize W H
Font size 9,Bold Location X ‘f

True Falz

Input T/F color [E] E]

[] Lppearance

| ok || Cancel |

Switch to the “Input Setting” page, key in "ON = 5 sec > OFF” in the Textbox of
“Show as string”, select “False - True” for "Mode Select”, set “"Switching Time” as
"5 Sec.”, and then click "Ok".

| commen [} Input Seting |
() Show as picture Mode Belect lm
@ S]'UJW&SSt[ﬂlg |(:|H = B - Swib:hjng Time gf_-c_
() Show as value Level

Boolean False I:I Azl hefore operation
e .

| Ok w || Concel
N

ICP DAS Co., Ltd. Technical document




Classification ISaGRAF FAQ-146

Author Raven Liu Version 1.01 Date  Oct. 2011 | Page 20/70

Next, create a “"g_ToPage” object. Drag & drop a “g_ToPage” into the editing area.

rage 1|

|Butb:um'[n1:uut w |

z B Inp

g WD _Inp Soft-GRAF Demo01

g F Inp

-

| i
2 Login ' J
g Logout a

2z ToPage \ ’ ] [ M --= 5 sec --=0FF
\|

Mouse right clicks on the object and select “Setting”.

[ Goto Page 2 ]P
Hetting
Delete

Cut
Capy

Set “Size W” as 100, "Size H” as 25, “Font size” as “9,Bold”, “"Fore Color” as the
below picture, "To Which Page” as 2 and "Title” as “"Goto Page 2”.

X

Size Wlmu |H |g5 | ] Lk before

Location X |5g |'f |g41 | Ask message I:I

Font size

Fore Color [-] R

Tevel |I:I 3 | To Which Page 9

[] Appearance Title CGoto Page 2
Ok || Cancel
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Mouse right clicks "Demo1l.sof” in the Project structure tree, and select "New Page”
to create page 2. The “Page Setting” can be left along, just click “Create”.

Froject

= % Mew Page w_

Page 4

/_

PageSetting E|
Title I

Eiack Color :]

Encode ITF-& w

Click “Page 2" to switch to the page 2.

Project

= Demol sof
Page 1

PageE\

Drag & drop a “g_ToPage” into the page 2 for return the page 1.

Project ¥iew
Page 2
ButtonTnput W \\
g B Inp
> GoToPage 1
g WD Inp

g F Inp
g N Inp
g Login

g Logout
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Set "Size W & H” as 155 & 25, “Fore Color” as the below picture, “To Which Page” as
1, “Title” as "Go To Page 1", and then click “"Ok".

g ToFPage El

Jize w H [] Ak befare
Locaton X [93 ¥ |3|:|—| Ask message I:l

Font size
B I—I
Fore Color : st message Are you sure

[] Lppearance Title o To Page 1

[ ok \][ Cancel |

Next, set up the upload IP configuration. Click "Project">"IP Setting”, enter the IP
address of PAC, and then click “Setting”.

Soft GRAF HMI Editor-Demo(]1 s
File | Project | Help

i 9| e =5
— N

PazWord

Tpload \—‘

IP Address

Click the upload tool icon L=, click “Yes” to answer the “save project?” question,
then the upload process begins. After uploading, the result shows up automatically
on the PAC’s VGA as the picture below if the HMI creation succeeds.

Soft GRAF HMI Editor-Demo(1 sof
File  Project  Help

ing%Elﬂﬂ
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ON --= 5 sec --=0FF

\14) Sawe Project?

e
‘{\

Pagel

Soft-GRAF DemoO1

| oN-»5sec —>0FF

Goto Page 2
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1.3 : HMI Objects Description

1.3.1: g_Label: Display a Label

Hello Word
3
(1) < Wet Waork Address Hize W 7g H |35 ;(5)
(2) < Fomnt zize 0, Regular Location X [1g4 |V 114 :(6)
(3) < Foire Calor [ﬁ TextAlign | eppey o »(7)
(4) < Back Color ] Title Lahel >(8)
| ok || Concel
Options :

(1)Net work Address: the ISaGRAF Modbus NetWork Address for the variable,
useless for in the g_Label object.

(2)Font size: set the font style and size of the label text, useless in other font
setting

(3)Fore color: the fore color of the label

(4)Back color: the back color of the label

(5)Size: the size of the label; "W" for Width, "H" for height.

(6)Location: the X,Y-axis of the label. Refer to Ch.1.2 for how to display the axis.

(7)Text Align: left, center and right align for the text

(8)Title: the text on the label. (Double click the Textbox to enter the long text.)
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1.3.2 : g_B_Val: display a text to show a Boolean value.

Description: Value= True Value= False

Displayed figure: Working Stop
(1) «——— Het ok Address 1 size  Wigs | H|zs | F—>(5)
(2) «— Font size [Q,Reguls.r] Location X 979 |Y [210 [F—>(6)

Falze Tiue Text&lign | capter v —(7)

(3) «— Fore Color | -l
(4) «— Back Color [i [ﬁ]

| ok || Cancel

Options:
(1)Net Work Address: the ISaGRAF Modbus Network Address for the variable
(2)Font size: set the font style and size of the text, useless in other font setting
(3)Fore color: the fore color of the object.
True: the fore color to display if the read ISaGRAF value is "True".
False: the fore color to display if the read ISaGRAF value is "False".
(4)Back color: the back color of the object
True: the back color to display if the read ISaGRAF value is "True".
False: the back color to display if the read ISaGRAF value is "False".
(5)Size: the size of the object; "W" for Width, "H" for height.

(6)Location: the X,Y-axis of the object. Refer to Ch.1.2 for how to display the axis.

(7)Align: left, center and right align for the text
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g B_¥al fEI
Left Text |—| —(8)
L s NoBlink v |—>(9)
Message false  [Off —(10)
Howmp —»(11)
| ok || Comel |

(8)Left Text: set up the text displayed on the left side of the object value. Ex: If set
the “Left Text” as "Status: ", the object will show "Status: True" when the
ISaGRAF Boolean value is "True”.

(9)Blink: Set the object text to blink. "No Blink": text not to blink, "Blink when true":
blink when the value is true, “"Blink when false": blink when the value is
False, “All Blink": blink when the value is True or False.

(10) ~ (11): the message to display when the value is True/False.
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1.3.3:g_WD_val ,g_N_val, g_F_val : Display a 16-bit Integer, 32-bit
Integer or 32-bit Float value

Studio: PAC:

Description: Set text Show text only Show text & value Show value only

= WD _Yal @

( 1 ) < Net Work Addres: Size W I?‘ H IF‘ > 5)
(2) < Font size Location X ‘f 4'(6)
@) —[Free ) | [ ~(7)
( 4) < Back Color :]

| ok || Comcel |

Options :

(1)Net Work Address: the ISaGRAF Modbus Network Address for the variable
(32-bit Long integer and 32-bit REAL variables defined in the ISaGRAF must occupy
two network addresses. Refer to chapter 4.2 of the “User Manual of ISaGRAF PAC".)

(2)Font size: set the font style and size of the text, useless in other font setting

(3)Fore color: the fore color of the object.

(4)Back color: the back color of the object

(5)Size: the size of the object; "W" for Width, "H" for height.

(6)Location: the X,Y-axis of the object. Refer to Ch.1.2 for how to display the axis.

(7)Align: left, center and right align for the text

(8) < [ Conversion Dot Iﬁ' > (10)
Oiriginal Falue Left Text [ ] > ( 1 1)
| || | Right e >(12)
WValue after
(9) | || |

[ox ) [ cownt ]
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(8)Conversion: check to convert the value (the g_F_val can input the decimal value)
(9)Original value: the range of the original value read(Ex: 0~32767,0~65535...etc.)
Value after: the range of the value after conversion(Ex: if the “Original value” is

0~32767 and the “Value after” is 0~1000, that means to convert the value
from range of 0~32767 to range of 0~1000, such as, 16384 is converted to
be 500.)

(10)Dot: define the number of digits displayed after the “.” , for the number after
conversion or the conversion not to use (Ex: Set “"Dot” as 3, the original
value “32767"” will be displayed as “32.767".)

(11)Left Text: the text displayed on the value's left side

(12)Right Text: the text displayed on the value's right side

Common | Setting-1 SETHJIE'E\

(13) «—| [] Enabls limit detsction Up-Limit Message  'Up-Limit | [T—>(17)

(14) «— Tplimt (33767 || [LowlimiiMesses |Low-Lumt | —>(18)

(15) «—-| Lew-Limit 33765 Fore  Back

(16) PR =TT —— Up-Limit Color ] —— . (19)
Lov-Limit Color (] [:]\»(20)

(13)Enable limit detection: check to enable the up/low-limit detection

(14)Up-limit: the upper limit value to detect

(15)Low-limit: the lowest limit value to detect

(16)Blink: select to blink or not when the value is inside/outside the limit range.

(17)Up-Limit Message: when the “"Enable limit detection” is checked, the message
will show up if the value is larger than the Up-Limit.

(18)Low-Limit Message: when the “Enable limit detection” is checked, the message
will show up if the value is lower than the Low-Limit.

(19)Up-limit-Color: when the “Enable limit detection” is checked, the text color and
background color will show up if the value is larger than the Up-Limit.

(20)Low-limit-Color: when the “Enable limit detection” is checked, the text color and
background color will show up if the value is lower than the Low-Limit.
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1.3.4 : g_N_Text: display a different text by the value of an integer variable.

Studio: PAC:

Description: Value = 0 Value =1 Value = 2

Displayed figure: [ g n_Text | OK! Enjoy it ~ OKay! Have fun ~ 1 like it, too 1

%]
(1)« Wet Work Address |1—| ForeColox E] »(5)
BackCola
(2): Font size 0 Reznlar :_E . L] :(6)
lign Center w :(7)
3y = M[mf e %8)
120t _
>(9
(4): Location X ‘f |R I—I \ )
[ Ok ] [ Cancel ]

Options :

(1)Net Work Address: the ISaGRAF Modbus Network Address for the variable
(32-bit Long integer and 32-bit REAL variables defined in the ISaGRAF must occupy
two network addresses. Refer to chapter 4.2 of the “User Manual of ISaGRAF PAC".)

(2)Font size: set the font style and size of the text, useless in other font setting

(3)Size: the size of the object; "W" for Width, "H" for height.

(4)Location: the X,Y axis of the object. Refer to Ch.1.2 for how to display the axis.

(5)Forecolor : the fore color of the object text

(6)Backcolor : the back color of the object

(7)Align : left, center and right align for the text

(8)Left Text : the text displayed on the left side of the object value.

(9)Right Text : the text displayed on the right side of the object value.

g N Text [Z'
common setting |{ Sefing w_
~
Mumber ForeColar BackColor New =( 10)
| »(11)
| >(12)

(10)New : create a new text
(11)Edit : edit the text
(12)Delete : delete the selected text
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*Setting description:

New
Click the “"New"” button to see the following setting window
£ N TexiNewltem El
(a)« Number |0 I_l:l Blink > (d)
(b) < ForeColor Text »(e)
() <+ BackColor m 1ad >(f)

(a)Number: if read this integer value, the object will display the setting text. Max.
50 numbers from 0~49.

(b)ForeColor: the fore color of the text

(c)BackColor: the background color of the text

(d)Blink: check to blink

(e)Text: the text to display

(f)Add: click to add this setting

Edit
Select the item want to edit, then click “Edit” to open the setting window. After edit,
click "Add” to save it. If forget to select any item, it will open the first item’s window.

cormon setting | Setting *\
N\

-
Mumber FareCalar BackColar New

Delete
Select the item want to delete, then click “Delete” to delete it. If forget to select any

item, it will delete the first item

| comumon setting | Hetting {
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1.3.5: g_B_Inp : create a button, when user press it, it display a keyboard
to input a Boolean to the mapping ISaGRAF Boolean vaiable.

Description: Show as string Show as value Show as picture

Displayed figure: st O ] [ True ] | .= Start |

........................

........................

(1) et Work Address [ Size W[5 |H [95 —(4)

(2) <«——]Foit sz 9 Fegular

Location X (457 |¥ (450 ——>(5)

Tiue Fal
(3) <«—{Input T/F color ]

Options :

(1)Net Work Address: the ISaGRAF Modbus Network Address for the variable

(2)Font size: set the font style and size of the text, useless in other font setting

(3)Input T/F Color: the color of True displays the fore color of the value when
ISaGRAF read it "True”. The color of False displays the fore color of the
value when ISaGRAF read it “False”.

(4)Size: the size of the object; "W" for Width, "H" for height.

(5)Location: the X,Y axis of the object. Refer to Ch.1.2 for how to display the axis.
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(6) < ) Show as picturs Mode 3elect  [Wammal o—T>(9)

(7)—| ) Show s string | Clek On Switching Time 2. [—*(10)
() Bhow azvalue Level 0 v (1)

(8) « Boolean False ||:| Azl before operation —>(12)
Boolean True ||:| [dentify Password —>(13)

(6)Show as picture : the button is showed as a picture. The picture format can be
JPG, GIF, PNG, BMP(BMP is not suggested due to the large size memory).
(7)Show as string: show the button as the setting text
(8)Show as value: depand on the value that Soft-GRAF read to show thereplaced
text
Boolean False: the text is showed when the read number is a False boolean
Boolean True: the text is showed when the read number is a True boolean
(9)Mode: select the input mode of the Boolean. There are 5 modes :
(a)Normal: can input True or False
(b)Only False: False only
(c)Only True: True only
(d)True > False : True first, and switch to False after a setting time
(e)False > True: False first, and switch to True after a setting time
(10)Switching Time: if select the Mode of “False>True” or “True->False”, set the
switching time here. The time unit is secent, and range is 1~10 secents.
(11)Level: set the permission level, used when the HMI has the permission setting
(12)Ask before operation: to ask again before operation
(13)Identify Password: to re-input the password of that level (Refer to Ch1.4 for the
permission setting.)
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1.3.6 : g_WD_1Inp, g _N_Inp, g_F_Inp: create a button, when user press it,
it display a keyboard to input a 16-bit signed integer, 32-bit signed integer
or 32-bit float to the variable.

Description: Show as title Show as value Show as picture
Displayed figure: Set WD_val ] ’ 2
(1)< Net Work Address () Show as pictire —»(6)
(2)+ Font size 9,Regnlar || | Show as titl L (7)
(3)< oz Lzl (I | [© show as Value (8)
(4)« Bize Wis [H |25
(5)« Location X o5 (Y 488
Options:

(1)Net Work Address: the ISaGRAF Modbus Network Address for the variable
(32-bit Long integer and 32-bit REAL variables defined in the ISaGRAF must occupy
two network addresses. Refer to chapter 4.2 of the “User Manual of ISaGRAF PAC".)

(2)Font size: set the font style and size of the text, useless in other font setting

(3)Fore color : the fore color of the object text

(4)Size: the size of the object; "W" for Width, "H" for height.

(5)Location: the X,Y axis of the object. Refer to Ch.1.2 for how to display the axis.

(6)Show as picture : the button is showed as a picture. The picture format can be

JPG, GIF, PNG, BMP(BMP is not suggested due to the large size memory).

(7)Show as Title: show the button as the setting text

(8)Show as value: show the value that ISaGRAF read
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common |{ Seting ¢
Lirnit Setting: Level 0 & >(11)
(9) <
-34768 ~ AT Iﬁ disk before operation |_>( 12)
& larm String [] Identify Pazsword —(13)
(10) < Lovwe-Lornit wal ton =mall
U p-Limit val too big

(9)Limit setting: set the up/low limit of the input value

(10)Alarm string: a pop-up window text when user input a value beyound the limit
Low-limit: the text when the input value is lower than the Low-limit
Up-limit: the text when the input value is higher than the Up-limit

(11)Level: set the permission level, used when the HMI has the permission setting

(12)Ask before operation: to ask again before operation

(13)Identify Password: ask to re-input the password of that level
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1.3.7 : g_Login : Create a Login button

This object creates a Login button. When users press it, a keyboard will display and
request the user to key-in a password. There are maximum 12 characters in a
password (only number 0 to 9). This g_Login object can only put on the Page No. 1
and only one g_Login allowed. When user presses the g_Login button, the Soft-
GRAF driver in the PAC will read a password file to check if this is a valid user who
has a permission level (1 ~ 10), and the larger number has the higher authority.
(Refer to Ch1.4 for the permission setting.)

Login I
 Logmg St
( 1) < Font size lm Title Login —»( 5)
(2) «———ForCalor ] Switch page 0 ————(6)
(3) «— 5= W75 H |35 Deny Mesmge hocess denied [T (7 )
(4) <—— Location X [359 Y 359 Wait Tine g SEC. —>(8)
| ok || Comel |

Options:

(1)Font size: set the font style and size of the text, useless in other font setting

(2)Fore Color: the fore color of the object text

(3)Size: the size of the object, "W" for width, "H" for height.

(4)Location : the X,Y axis of the object. Refer to Ch.1.2 for how to display the axis.

(5)Title: the text displayed on the button

(6)Switch page: the number of page want to switch to when login successfully

(7)Deny message: the message want to display when the login fail.

(8)Wait time: the period of time to auto-Logout. The unit is second. The value can
be 0 and 10 ~ 3600; 0 means do not enable the auto-logout (Need to press
the g_Logout button to logout.). Ex: set the "wait time" as "60", Soft-GRAF
will auto-logout and switch to the first page if user has not any operation
over 60 secents after login the HMI.
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1.3.8 : g_Logout : Create a Logout button

This object can create a Logout button. When user presses the button, it pops up a
confirmation dialog. If user answers “Yes”, the Soft-GRAF will logout and switch to
the first Page (Page 1). (Refer to Ch1.4 for the permission setting.)

Logout I
£ Logout E|
Loging Set

(1) <« Font size o, Regular [itle Logout »(5)
(2) < Fore Color E]

(3) < size W75 H |25

(4) < Location ¥ (103 W aag

| ok || Camcel |

Options:

(1)Font size: set the font style and size of the text, useless in other font setting
(2)Fore Color: the fore color of the object text

(3)Size: the size of the object, "W" for width, "H" for height.

(4)Location : the X,Y axis of the object. Refer to Ch.1.2 for how to display the axis.
(5)Title: the text displayed on the button
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1.3.9 : g_ToPage : Create a switch-page button

Description: Show as text Show as picture
Displayed figure: 5oto Pagez 4  Back
 ToPage Settme ;
(1) <« ize W75 H |25 || &usk before operation »(7)
2) <« Location X |5 T 430
(2) bzl message »(8)
(3) <« POt size 0,Regular |
(4) <« Fore Color -] Demy message Access Deny. | ——(9)
(5) <——|-Leve1 0 To Which Page 0 —(10)
< e Ag pachire 1 o Page
6 Sho i Title Ta P —(11)
Options :

(1)Size: the size of the object, "W" for width, "H" for height.

(2)Location: the X,Y axis of the object. Refer to Ch.1.2 for how to display the axis.

(3)Font size: set the font style and size of the text, useless in other font setting

(4)Fore Color: the fore color of the object text

(5)Level: set the permission level, used when the HMI has the permission setting.
When user’s login permission level is higher than this level, the user can
access the function.

(6)Appearance: show the object by a picture. The picture format can be JPG, GIF,
PNG, BMP(BMP is not suggested due to the large size memory).

(7)Ask before operation: to ask again by a pop-up window before operation

(8)Ask message: the text in the pop-up window of "Ask before operation"

(9)Deny message: the message will show when the user Level is too low to access the
switch page. Its default message is "Access denied !" if left it blank.

(10)To Which Page: the page want to switch to

(11)Title: the text displayed on the object
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1.3.10 : g_B_Led : can display a LED picture to show a Boolean value.

(1)

(2)

(3)
(4)

Options:

A

A

A

A

Net Work Address |4 Message when false | gt —P( 5)

True Fal:z bessage when Troe oy —>(6)
Input T/F color [ﬁ] [ ] T Reotngls v _»(7)
Size W70 H [7g Fomt —(8)
Location X 29 ¥ 1130

Ok || Concel |

(1)Net Work Address: the ISaGRAF Modbus Network Address for the variable

(2)Input T/F Color : the color of True displays the fore color of the value when
ISaGRAF read it “True”. The color of False displays the fore color of the
value when ISaGRAF read it “False”.

(3)Size: the size of the object; "W" for Width, "H" for height.

(4)Location: the X,Y axis of the object. Refer to Ch.1.2 for how to display the axis.

(5)Message when False: the text showed on the object when read a False value

(6)Message when True: the text showed on the object when read a True value

(7)shape: set the Led shape, can be rectangle or ellipse

(8)Font size: set the font style and size of the text, useless in other font setting
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1.3.11 : g_B_Pic : Display a picture to show a Boolean value.

The picture format can be JPG, PNG, GIF or BMP (BMP is not suggested due
to the large size memory).

Net Work Address |

(1) «—

(2) «— Rize Wiize  |H 128

(3) < Location X [975 Y |45

(4) N Tme File [ No_Pi ]
(5) «——|Bal=File | No_Pic |
| ok || Concel
Options:

(1)Net Work Address: the ISaGRAF Modbus Network Address for the variable

(2)Size: the size of the object; "W" for Width, "H" for height.

(3)Location: the X,Y axis of the object. Refer to Ch.1.2 for how to display the axis.

(4)True File: the picture showed when read a True value (Refer to Ch.1.5 for more
about the dynamic image format).

(5)False File: the text showed when read a False value (Refer to Ch.1.5 for more
about the dynamic image format).
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1.3.12 : g_N_pic : Display a picture to show a Integer value.

The picture format can be JPG, PNG, GIF or BMP (BMP is not suggested due
to the large size memory).

Studio: PALC:
Description: Value= 0 Value= Value = 2
Displayed figure: g_M_Pic = - - -
]

(1) < NetWork Sddress

()= "™ Fm |

(3): Lacation X|1';.'3 |Y|14g ‘

[ ok || Comel |

Options :

(1)Net Work Address: the ISaGRAF Modbus Network Address for the variable
(32-bit Long integer and 32-bit REAL variables defined in the ISaGRAF must occupy
two network addresses. Refer to chapter 4.2 of the “User Manual of ISaGRAF PAC".)

(2)Size: the size of the object; "W" for Width, "H" for height.

(3)Location: the X,Y axis of the object. Refer to Ch.1.2 for how to display the axis.

2 N _Pic (%]
Mumber Ficture New > (4)
>(5)
| >(6)

| ok || Coneel |
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(4)New: open a setting window to add a new picture
(5)Edit: edit a picture setting

(6)Delete: delete a picture

* Setting description:

New
Click the “New” button to see the following setting window

# N _Fic Newltem
Eumber i | » (a)

— (b)

Add c)

(a)Number: if read this integer value, the object will display this setting picture.
Max. 50 numbers from 0~49,

(b)Picture: the picture’s file name to display

(c)Add: click to add this setting

Mumkber Picture New

Dielete

Led02-=-0. gif

7

Edit
Select the item want to edit, then click “Edit” to open the setting window. After edit,
click "Add” to save it. If forget to select any item, it will open the first item’s window.

Delete
Select the item want to delete, then click “"Delete” to delete it. If forget to select any

item, it will delete the first item
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1.3.13 : g_Trace2 : display a 2-axes (X, y) or 1-axis (x : Horizontal) or 1-
axis (y : Vertical) moving trace map

25000 5000
62500 124000
0 0
1] 125000 250000
1} 1]
[ T T T I I I
L A B
0 12500 25000

Please drag the object into the editing area and select one of the axis options: Only
x-axis, Only y-axis, x and y axis.

£ TraceNew @
Az W create

(1) «———H-huis Address [ Left Lt 0 —>(7)
(2) Y-dodis Address [ RightLimit (1000 ——»(8)
(3) «———]iction Address | Lower Limit 0 —=>(9)
(5) <« wize  Wizag  |H 235
(6) < Location X [y VT

| ok || Comel |

Options:
(1)X-Axis Address: the Network addr. of ISaGRAF variable for the X-axis
(2)Y-Axis Address: the Network addr. of ISaGRAF variable for the Y-axis
(32-bit Long integer and 32-bit REAL variables defined in the ISaGRAF must occupy
two network addresses. Refer to chapter 4.2 of the “User Manual of ISaGRAF PAC".)
(3)Action Address: the Network addr. of ISaGRAF Integer variable.
0: no drawing (type 0: stop) ; 1: drawing both of trace curve and the
current point (type 1: drawing both) ; 2: drawing only the current point. ;
Not within 1 ~ 8191: the same as type 2, drawing only the current point.
(4)Clear Address: a ISaGRAF Boolean variable. Its network address can be 1 ~ 8191.
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If the Boolean is True, the trace curve is cleared once, and then Soft-GRAF
will change the Boolean to False automatically. In ISaGRAF software, user
can manually set the Boolean to True to clear the trace curve. If its network
address is not within 1 ~ 8191, the clearing function will not enable.

(5)Size: the size of the object; "W" for Width, "H" for height.

(6)Location : the X,Y axis of the object. Refer to Ch.1.2 for how to display the axis.

(7)Left Limit: set the left limit of the X-axis in the trace map

(8)RightLimit: set the right limit of the X-axis in the trace map

(9)Lower Limit: set the bottom limit of the Y-axis in the trace map

(10)Upper Limit: set the upper limit of the Y-axis in the trace map

(11) «— [v] Ehow Seale Trace Color [:] —> (16)
(12) «—— XDivision 1 Soale Color [E] — (17)
(13) «———— 7 Dwim 1 FomtColor | ] . (18)
(14) «—— ™™ L
(15) Back Color [E]

| ok || Comel |

(11)show scale: check box to show the border of the axis and its scale

(12)X Division: if "show scale" is checked, it means displaying the current position
value at the bottom and divide the X-axis by this integer value.

(13)Y Division: if "show scale" is checked, it means displaying the current position
value at the bottom and divide the *-axis by this integer value.

(14)Font: set the font style and size of the text, useless in other font setting. The
maximum size is 10 and the minimum is 6 for this object.

(15)Back Color: the backcolor of the trace map

(16)Trace Color: the color of the trace curve

(17)Board Color: the color of mesh and border

(18)Point Color: the color of the current point
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1.3.14 : g_Bar : display a Bar-meter picture to show a 32-bit signed integer,
16-bit signed integer or 32-bit float value

fry
s
E
X

(1) «—F—|Net Work Address g Scale color () >(6)
(2) «——|siz W(zan  |H (a0 worl v >(7)
(3) « [Towton %5 7 1g7 | | Shov Vel . (8)
(4) «<—F— |Fore Color E] show Scals >(9)
(5) < Back Color |

[ ok ][ Comel |

Options:

(1)Net Work Address: the ISaGRAF Modbus Network Address for the variable
(32-bit Long integer and 32-bit REAL variables defined in the ISaGRAF must occupy
two network addresses. Refer to chapter 4.2 of the “User Manual of ISaGRAF PAC".)

(2)Size: the size of the object; "W" for Width, "H" for height.

(3)Location: the X,Y axis of the object. Refer to Ch.1.2 for how to display the axis.

(4)ForeColor: the fore color of the Bar-meter

(5)BackColor: the back color of the Bar-meter

(6)Scale Color: the color of the scale

(7)Data Type: select the data value type. Can be "long" (32-bit sign intger), "word"

(16-bit signed integer) or "real" (32-bit float).

(8)Show Value: check to show the current value.

(9)Show Scale: check to show the scale
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£ Bar @

Using Alarm >(13)
(10) <«
a ~ 1000 Up-Alarm 600 >(14)
[ ] Unit Trenster Wikl Calbr ) >(15)
(11) «— Low-Alam 300 >(16)
(12) < Dot 01 v Lowwe-Alarm Color :] >(17)
slaninlbbal. NoBlink v >(18)
| ok || Comal |

(10)Bar Range: set the maximum and minimum limit of the Bar range

(11)Unit Transfer: the unit transfer function. If checked to enable, it transfers the
value according to the range of Bar Range. Ex: Bar Range = 0.0 ~ 1000.0,
means the minimun value is 0.0, the maximum is 1000.0; set Unit Transfer
= 0~32767, it will tranfer ( 0 ~ 32767 ) to ( 0.0 ~ 1000.0 )

(12)Dot: define the digital number after the dot, can be 0 ~ 6.

(13)Using Alarm: using the Alarm function. If checked to enable, then can set the
value and color of Low-Alarm/Up-Alarm.

(14)Up-Alarm: the Up-limit of the Alarm

(15)Up-Alarm Color: the color of the Up-Alarm

(16)Low-Alarm: the Low-limit of the Alarm

(17)Low-Alarm Color: the color of the Low-Alarm

(18)Alarm Blink: set the alarm blinking options when the value is larger/smaller
than the Up-Alarm or Low-Alarm. There are 4 options:
(a)No Blink: no blink
(b)Up-Alarm: blink if larger than the Up-Alarm value
(c)Low-Alarm: blink if smaller than the Low-Alarm value
(d)All Blink: blink both when larger and smaller
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1.3.15 g_Rect : Draw a rectangle

(1)4— Hize Wien [H =g

(2)<«—{ Location X 365 |7 [229
(3)4_ Edge Width |7

(4)<«—] RectColor [E]

(1)Size: the size of the object; "W" for Width, "H" for height.

(2)Location: the X,Y axis of the object. Refer to Ch.1.2 for how to display the axis.
(3)Edge Width : set up the border line’s width, 1~10.

(4)Rect Color : set up the border color of the rectangle
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1.4 : How to set up the access permission of HMI

The Soft-GRAF provides a password setup for the HMI security, please refers to the
following steps. The HMI password security is accomplished by the menu of
"Project" > "password" and two HMI objects "g_Login" and "g_logout".

The Setting Steps:

(1) Open a project of the Sort-GRAF Studio and lick the "Project">"Password"

Fie | Poject | Help
i § | | IPSetting AL e
i EREIEIN
Upload B

(2) Set the password and level

PazzWord Dlg §|
Level 1 w B :(a) All Password g|
Pazswond >(b) Paszword -
» 123456
123456
(a)Level: the security levels can be Level 7 NULL
1~10. The larger number has the Leveld NULL
higher authority. Click the button Level > HULL
B . Lewel HULL
to see the setting passwords Lol ? ——
for all levels. "NULL" means that Lol ——
level doesnot set password. Lol ——
v

(b)Password: the password of the
selected level.
(3) Create a new password: first, select a Level. If this level has no password yet,
it is blank. Then, key in a password and click "Create".

Pasz:Wornd Dlg
Level 1 b
Passwond 123456]

(4) Change/Delete password: select the Level that wants to change. The
"password" column will show the current password. Key in the new password
and click "Create" to replace the password. If user wats to delete the
password, please click "Delete".
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(5) In the HMI editing area, drag the g_Login object into the “Page 1”

Project View

Page 1

ButtorTnput W
g B Tnp

g WD _Inp

=}

o F Inp Login

g N Inp

B
\

g Logont

g _ToPage

(6) Right key click on "Login" button, select "Setting", and then enter the page
number that want to switch to for the Login button. Enter page number "2" for

this demo.
Laogin L -
________ am Getting
Delete
Cut
Capy

Fomnt size 8, Regular Title Login

Fore Color [E] Suritch page 2

Rize W75 H 35 Deny Message Arccess denied
Location X |49 Y |55 Wait Tine g SEC.

Ok \]\[ Cancel

N
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(7) Switch to Page 2, and drag the "g_Logout" object into the editing area. Now
this page is protected by the password security.

Project

o LogmnDemo sof
Page 1

Page 2
ButtonsTnput w

g B Inp

= WD _Tnp

g F Inp /> [ Logout @

g N _Tnp

g_Login

g _ToPage

(8) Upload the project to the PAC. Click the "Login" button and enter password
can login the HMI project. Click Logout button can exit the HMI project.

Pagel

Logir
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1.5 : How does the Soft-GRAF driver distinguish the picture animate or not?

NOTE: Only the objects g_B_Pic and g_N_Pic can use the animate picture that
support by Soft-GRAF.

The animate picture file should be named as *(ABC).gif (or .jpg or .png). The ABC is
three number of 0 ~ 9. If the picture format is correct and the file name is correct,
the Soft-GRAF driver will display it as animate picture. The AB defines the amount of
pictures to be animate. The C defines the time-period to switch pictures, can be 0 to
9. If Cis 0, it means the picture is not animate. The unit of C is about 0.125
seconds for XP-8xx7-CE6 PAC, while is about 0.25 seconds for WP-8xx7 and VP-
2xW?7 PAC.

For ex., '\gif\Fan04-s-(061).gif' means the file is an animate picture. It contains 6
pictures. The switching time is about 0.125 seconds for the XP-8xx7-CE6 PAC
( about 0.25 seconds if running in the WP-8xx7 and VP-2xW7PAC).

For ex., '\gif\Fan04-s-(062).gif' means the file is an animate picture. It contains 6
pictures. The switching time is about 2 x 0.125 = 0.25 seconds for the XP-8xx7-CE6
PAC ( about 0.5 seconds if running in the WP-8xx7 and VP-2xW7PAC).

For ex., "\gif\Fan04-s-(060).gif' is not an animate picture because the switching
time is 0. The following picture is the content in the \gif\Fan03-s-(041).gif . It
consists of 4 small pictures to become a big picture (from left to right). The Soft-
GRAF driver will display it as animated picture.

'T_ .’5.. A ."'L,V s ."QA_ — ‘I:
)4l $ di 81' e_i
User can find the default burned-in pictures in the following CD-ROM or web site.

WP-8xx7 CD:\napdos\isagraf\wp-8xx7\driver\wp-8x47\1.37\sofgrafy\
XP-8xx7 CD :\napdos\isagraf\xp-8xx7-ce6\driver\1.18\sofgrafy\
VP-2xW?7 CD:\napdos\isagraf\vp-25w7-23w7\driver\1.29\sofgrafy\

or www.icpdas.com > FAQ > Software > ISaGRAF > FAQ-146 in the
downloaded ZIP file.
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1.6 : Other Features introduction

The Soft-GRAF Studio provides the Clipboard and the function of arranging the
object layer order.

1.6.1 : Use Clipboard Feature to Copy the HMI Object
The clipboard allows there stardard commands: Cut, Copy & Paste

(1) Using the hot key :

Ctrl+X : Cut the object
Ctrl+C : Copy the object
Ctrl+V : Paste and replace the object after the Cut or Copy

Operation Example:

Label '\i\
U Ll

Mouse left click on the object, then

press keyboard Ctrl+X or Ctrl+C

Lahel V»
Lahal 1 Press Ctrl+V to paste the

object

(2) Using the tool icon :
Use the clipboard icons in the tool box

Operation Example:
Mouse left click the object, then the icon “"Cut” or “Copy”, and then the icon "Paste”.

File  Project  Help
Gl ]y B3
% Cut or Copy

Lahel

=]

Label
|| |

File  Project Help

P9 o 36 O ST Y
~N

Label

Paste
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(3)

Using the mouse right key :

Mouse right key click on the object, then select the "Cut” or “"Copy” from the popup
menu. Then, mouse right key click on the blank editing area and select the "Paste”.

1.6.2 : Use Clipboard Feature to Paste the Text into HMI Object

Label L -
o Hetting
Delete
Cut
1\>
Copye— |

Cut or Copy
the object

==

After copying the text, mouse left click the box of “Title” in the HMI, then mouse
right click and select the “Paste”.

5
Conumon |
Net Work Address I— Size Wlﬁ H 'W
Font size 12,Rezul I Location X [sp7 ¥ lﬁ
Fore Color - Text Align m
Back Color

|

Title II_

BRI

BRIy
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1.6.3 : Adjust the Objects order

Soft-GRAF Studio offers the function to adjust the layer order of the object. The first
created object in the Soft-GRAF Studio default has the highest level Layer. The
higher Layer object is above the lower Layer object when the objects overlap with
others. User can change the Layer level to use the overlapped object. When you
click an object, its layer level and position will show on the left-up corner of the HMI
editing area, the larger number Layer with the higher level.

[x=270v=15 Laver =5,z WD_Val]
Page 1

Operation Example:

There are two overlapped objects, g_Label (Label button) and g_B_Inp. The object
g_Label has the higher Layer than the g_B_Inp, and covers on it.

Label Inp |

- p—

Select the Label and click on the tool icon “Sent to Back"®, then can see g_B_Inp .

EFEEY ey -
Froject Wiew ~
Bution/Tnput v REE Label] o_B_Inpg b=

] F|

When the HMI page needs a background picture, please add it via g_B_Pic object.
(Recommand user to add it at the last step for the convenience.)
First, drag a g_B_Pic object.

Label | Inp

Page 1

Diraveing W

z B Led
g B_Pic

g N P |

2 Traced

g Bar
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showing up.
a
Setting I
Delete
= Cut
Copy
Pic Betting |
Wet Work Sddress EI
size W|1za |H |12=3 |
Location X |1g |‘f |1g |
Al Ho b
el % E
BHO: | Pic v Q2@
\ w;\
{ %] Led03-B-m-1.
SERREE | [ Soft GRAF-1 gif
T
A
Ei= Dl o
?EE’I*JQM
B LESHE g oy |Elue hills jpz v| [(FEow]
a8 AR (T | A1l Tmage Formats(™® bmp* jpg-* gif ¥ pngd  » | HiE

Mouse right-click on the object, select “"Setting” and set the “False File”. Select a
background picture for the “False File” and then click “"Ok”. If the picture is covering

other objects, please select it and click the “Sent to Back” until all other objects
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Fio Setting |

Wet Work Lddress EI

wize W|enn |H |6IZIIZI |

Location K||:| |'f |2 |

Troe File | No_Fic ]

FelseFile [ Blue hilljpz o

| ok w | Concel
<
P |
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1.6.4: Switch the Soft-GRAF HMI page by ISaGRAF program

User can declare the below two ISaGRAF integer variables to switch the page of the
Soft-GRAF HMI and to read the current page number. (Note: Only the Soft-GRAF
driver version 1.06 and later version supports this function. )

The integer variable which with the network address number 8191 (Hex is 1FFF) is

for switching the Soft-GRAF page. Please must declare it as “internal” and assign an
initial value 65535. For example, as the “"To_Page” in the below table. If setting it as
1, the Soft-GRAF HMI will switch to the Page 1 and then this “To_page” will be reset
as 65535 by HMI automatically. If setting it as 2, the Soft-GRAF HMI will switch to

the Page 2 and then the Soft-GRAF HMI will reset “To_Page” as 65535 automatically.
If setting it as a non-existing page number, the Soft-GRAF HMI will not swtich the

page.

The integer variable which with the network address number 8190 (hex is 1FFE) is
for reading the current Soft-GRAF HMI page number. The value can be 1, 2, 3, ...

Name Type Attribution NetWork Description
Addr.
To_Page Integer Internal 8191 must set an initial value 65535.
(Hex = 1FFF) |for switching HMI page
Current_Page Integer Internal 8190 For reading the current page
(Hex = 1FFE) number.

Inte ger/Feal Yariable

T |'|"3'_F'-flEIE | Metwork Address;  [1FFF

Comment: |set initial walue to 65535, Mefwork addr. iz 3131 [Hex=1FFF)

Nk

[t | | Corversion: | [nane] j|
—Attibutes————— Format
* |nternal {* |nteger |[standard] j| =
i |nput " Real Cancel |
€ Dutput Newt |

(™ Corstant Iritial walue:  |B5535
- Previous
Retain

pm: [ ] Exended

I
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1.6.5: Check/Upgrade the Soft-GRAF driver version

Check the current Soft-GRAF driver version: click the left-top corner of “Page 1”.

This is Page 1

Welcome to the Soft-GRAF Demo 01. Please
visit www.icpdas.com > FAQ > Software =

ISaGRAF > FAQ-131
o
. J& Soft-GRAF driver version 1.01 , Sep.21,2010

OGN/ OFE| [ON-—> 5 sec —> OFF |

| Goto Page 2 |

Upgrade the Soft-GRAF driver:

1. Stop the running ISaGRAF driver

XP-8xx7-CEG ISaGRAF Driver

had
Settrg | web | about |
isaxPcet - cglave 1 bner : Il

Madbws RTU Slave Part COM2

paudrare  fiszoo [Lmog 1 | modfy. |

- Frogect
Current application Iu\p_vb[)ii, 1541 1=195A, [SA12=376 Dalate |

it IO = @L

2. Download FAQ-146 (http://www.icpdas.com/faqg/isagraf c.htm > 146), and copy
the file "Soft-GRAF.exe” in the “faql46_demo_chinese.zip” to the directory of
\system_disk\isagraf\ in the PAC via ftp or USB disk method (replace the old file

“Soft-GRAF.exe").
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1.6.6 : To display the Soft-GRAF HMI with real FULL SCREEN

When complete all design and testing of the control logic and Soft-GRAF HMI, user
may do the following setting to display the Soft-GRAF HMI with real full screen. This
prevents anyone to mis-operate the PAC's OS.

@ Prograrms »
% Favorites b Taskbar, and Start: Menu
) Documents  * General | Advanced

[ Contral Panel [ ] Ahways on tap
(}, Metwiork and Dial-up Connections : ;

B Taskbar and Start Menu...

B Settings

& Help

[]2uto hid e
[ ] show Clock

WinPAC Utility [2.0.1.5]
== Help Configuration

My
Documents

W

Save and Reboot

Reboot Without Save
Restore Default Settings
Exit

WINPAC ..

WinPAC

® " Industrial Control Products
\C
ﬁb’; Data Acquisition System

How to stop the real full screen ?
When the PAC is setting as “Toolbar Auto hide”, the Soft-GRAF HMI will occupy the
full screen. Then it is not possible to do any operation with the PAC's OS. There is
two possible ways to solve this problem.
1. (Recommend using this way) : PC running ISaGRAF to connect to the PAC and
then click “Stop application” .

-

File Contol Tool: Option:  Help
@ri= » | & Ao
RUN allowed=0 current=3
| Stop spplication plication stopped
2. Power OFF the PAC and turn the PAC's Rotary-switch to 1: Safe mode, Power it

up with “Safe Mode”.

overflow=0

maximum=120
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1.6.7 : File management for user edited pictures

Picture files in the PAC:

All user used pictures in the project will be stored in
"\System_Disk\ISaGRAF\sofgrafy\user\” directory after upload into the PAC. If there
are too many pictures and you want to manage them, you can delete all the
pictures files under “\System_Disk\ISaGRAF\sofgrafy\user\” (But do not delete the
folder “user”.) and upload pictures again via Soft-GRAF Studio.

Address |'Systern_DiskNSAGRARsofgrafyse

MHarne | Size | Type

=[07,jng ; 14.1KE  JPEG Image
=) 08.jpg 13KE  JPEG Image
@air-(ﬂzljl.gif 0.75kE  GIF Image
@air-l.jpg 3.29:B  JPEG Image
@ hack, jog 4.14KB  IPEG Image
= back-b.jpg 4.16KE  IPEG Image

For saving the upload time, Soft-GRAF checks the file name and size when upload
the project to the PAC to decide overwrite that file or not. If the file size is the same,
it will not upload that file. So, when the picture of HMI screen is not update, please
delete the non-updated files in the “\System_Disk\ISaGRAF\sofgrafy\user\”
of the PAC, and then upload the project again via Soft-GRAF Studio.

Picture files in the PC / Soft-GRAF Studio:

Normally, the Soft-GRAF Studio will copy all user edited picture files to the
D:\Soft-GRAF Studio\ <project-name> \pic\ directory when using them. If user
wants to modify the picture file, please close the Soft-GRAF Studio first, then edit
the picture file in the D:\Soft-GRAF Studio\ <project-name> \pic\ directory.
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1.7 The description of some Soft-GRAF Studio demo projects

1.7.1 Demo04: display the Objects and the HMI access

This demo displays all HMI Objects and basic operation. First, restore “"demo04.pia”
and upload it to the PAC.

(78 TSaGRAF - Project Management
z thmns ﬂ&l]:l

File Edit Froject

D ]
@ sofgr_08 Libraries Cormmion data
an sofgr 09 ImportIL program [ 10 www cpdas col
rmm anfor 01 T (vaenesne icnrlas came
Archive - Projects E
Workbench Archive
creation - m
dema_01 | |demals N
demaol?2
demal? Bestore
dermnaold
dema0s Cloze
el 03 —
el 04 —
el_05 Help
m34_ 05
gofgr_~2
gofar_00
sofgr_01
sofgr 02 = |v Compress
Archive location
[eASOFTS Browse

- ISaGRAF - DEMO04 - Programs

File Make Project Tools Debug Option: Help

|n%m|mm|$m¢|m§a|a|

Begin: @ Generate & pulze M1 and get Time
5T1
WINPAG-8x47/8x46/8x37/8x36 ISaGRAF Driver

Setting | web | About

Configuration
Slave Mumnber |1
Maodbus RTU Slave Port INone

Baud Rate | [EE TN

Project
Current Applicatior] IclemouqJ 13811=1384, ISA1Z=016 Delete
Elapsed Time Joeo:12:38 End Driver
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Use Soft-GRAF Studio software to open “demo04.sof”. It shows as below. (Refer to
Chap.1.2 for the steps.) Set up the upload IP and then upload the project.

Fib: Fuoojzet  Belp

L R N N R

Fe i | AT 3 -4 Lamm — L |
=
-
’—” e Soft-ERAF Dariold, Please visit wmw.icpdas.com [ rme e ] =
» Faq »1SaGRAF » FAD148 _
5Dl
T Snp
W v
- o3
EEu © @
St Sot WD_val 1 am
g wy = |
Hlil
N I TR | | |
hi]
J_H_mp I
G Page 2 1 &
5000 =003 =
B, Rl =l I 101
= Lo Al w200 i i
Prpa L
Pog -
T'-g : a 0 Al
] 125000 oS0 01
i @
i
1 1 1 1 1 1
1T |
i}
b =n Thn =
a
+ | >

Soft-GEAF Studio -Demo(4 sof

File | Pmject | Help

IP Zetting

P § |
P_roj PazWord [x

Upload

P Addeess 192 | | 168 | 1

File  Project  Help
P9 H

Froject View
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The HMI screen of PAC is as the following picture. "Demo04” contains three HMI
pages: Pagel displays all objects, and Page2 & Page3 display the using of security.

Pagel:
Soft-GRAF Demo04. Please visit Tims =11: 46: 1
o cpdas com > Foq FISaSUAL > FaquS —)
5 514
(1) a0
A -
B0
n(
- »(6)
Goto Page 2 s
(2)e—— 1.057kg
125000 125000 =
-
62500 A2500 200
(3)‘_ 0 0
i} 125a08 25000
Lo
E====m==== — “
.
O L

Description and testing:

(1) Use a Boolean variable to test g_B_val, g_B_Inp, g_B_Led, g_B_Pic. Set the
g_B_Inp as different input type to switch the Boolean variable, such as, press
the button "ON-> 5 sec > OFF” can set the Boolean to “True” for 5 seconds and
then set it to “False”.

(2) Switch to Page?2.

(3) Display the Trace function — draw the curve according to the read value. Setting
the “Action Address” can select the way to draw, and setting the “Clear Address”
can clear the curve by manual. In the HMI Page2, user can press the button
“Clear” to clear the trace curve.

(4) Display a Bar-meter.

(5) A g_N_Text object: display the specific text according to the read value.
(6) The buttons set a Word, Integer or Float value from up to down.

(7) Press the login button can go to Page?2.
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Page2:
(1) < T Bt l a_ToPage(] with level2 security, pls login as

level 2 or Higrt user to operate it

L ,(5)

(2) < LogoLt ] ’ Goto Page3 ]

g_F_inprwith level2 security, pls login as level 2 or Higher
user to operate it

(3) < 1057

a_F_inpwith level 1 security, pls login as level 2 or Higher
user to operate it

(4) — 1.057

(1) Press the button to go to the Pagel

(2) Log out. If login from the “Login” button of Pagel and login successfully, press
this button can return to Pagel and logout.

(3) This is a g_F_Inp object with the level 2 authority protection. If user does not
login with the Level 2 (or upper Level) password that setup in the Soft-GRAF
Studio designing step, user cannot input this Float value. For test this button,
please go to Pagel, press the button “Login” and enter the password "012345",
then the system will go to Page2 automatically, and then user can press this
button to change its value.

(4) The function is the same as (3). For testing, go to Pagel and enter the Level 1
or Level 2 password.

(5) Switch to Page3. This button, the same with the authority protection, switches
to Page3 only when the user logins in with the password of Level 2 or upper
level.

Page3:

l Gotoo Pagez H—1)

(1) Switch to the Page?2.
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1.7.2 Demo05: My Sweet Home Demo Description

This demo shows how to design an interactive and dynamic HMI page. Restore
“demo05.pia” and upload to the PAC.

|4 ISaGRAF - Project Management

File Edit FProject

D Archive
sofgr_08 Libraries Comumon data
sofgr_09 Import IL progmm  F 10 v icpdas.coi
rm anfar N1 T rusaind icnrl=as coeme

Archive - Frojects E
Workbench Archive

creation a| |demold

demo_01 —

demol2

dernol Restore <

demol4

demol5 Cloze N

el 03 —

e 04 —

el_05 Help

m3d_05

zofgr_™2

zofgr_00

zofgr_01

zofgr_0Z2 = v Compress
Archive location
DoASOFTh Browse

-- IRaGRAF - DEMOOS5 - Frograms

File' Make Project Tools Debug Optons: Help

B HRX DED *Xie DH 0%
Begin: I@ Generate a pulse b1 and get Time

Configuration
Slave Murnber : |1
Maodbus RTU Slave Port INu:une

Baud R.ate |192|:|c| |JN, g 1
Project
Current Application |dem.:.|:|5, ISa11=1516, ISA12=1132 Delete

Elapsed Time |1:3:55:37 End Driver
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This demo default without use I/O card. If need the I/O card, user can install an I-8056W in the
Slot 1 of the PAC, change the i_8056 of the IO Connection setting in ISAaGRAF project to “Real
board”, re-compile project and download it into the PAC. The DO control points in this demo will
output to the I-8056W card.

- ISaGRAF - DEMOO5 - Frograms

File Make Project Tools Debug Optons:  Help
B HRE DE0 | FXe: mE 22
N

B eRR20 ¢l FR S8

[o] N ~| v ref = 8056

EN = i 8056 | nae @ D00 (* addr=20, init=True *1
N\ & DO (* addr=21, irit=True *)
El = i_8056 n+ & DOO (* addr=20, irit=Trus *)
2 | \ @ DO1 * addr=21, init=True *)

Use Soft-GRAF Studio software to open the "Demo05.sof” as below. (Refer to Chap.
1.2 for the steps.) Set up the Soft-GRAF Studio upload IP and upload the project.
(Refer to Chap.1.7.1 for the steps.)

File  Project Help

R e I . A e i

“iject Vi | [x =301, y=302, Layer =01
Fage 1 |

Label/Value v
e Label My Sweet Home

== W] 1 o
2 WD_val mm a_

g F_val g_N_Text

7" (To See My Family)
(To See My Family)

Fage O Welcom to the Soft-GRAF demo05 ~ Please refer to
Page 10 www.icpdas.com > FAQ > Software > ISaGRAF > FAQ-146
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The HMI screen on the PAC is as below. Demo05 has 10 pages and illustrated as

following.
My Sweet Home
2011410 f 18
14 : 59 : 37
Tuesday
I/'—'\
\:I'o See My Family
Welcom to the Soft-GRAF demo05 ~ Please refer to
www.icpdas.com > FAQ > Software > ISaGRAF > FAQ-146

Back to () Back-]| My Family

previous - :

page

: Rare an_lg)l
(3575 8 H)

\ 4

To Page 2

Press to
different
pages
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Back to
previous

page

Press
ON/OFF
to show
different
effect.

Back to
previous

page

] S

(<) Back |

Elephant

Turtle

Input value (1~8)
to switch the
pictures.
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— Ladybu
Back to <+—| (< Back ybug
previous
page I like to take a bubble bath in Ladybug's home ~

Ladybug wants to say something :

EseS

(1)~(3): 8

Input values (1~3) to
show different text

Back to <« < Back Hippopotamus

previous 25.0

page 2 Press ON /

' OFF to show
e different
I ] 7 effect

(17 -~ 28) >

Can give an Integer to set
the temperature

L —_
{ ® ®
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— Lucky Cat

Back to ||\-q) Back | ky

previous — -

page

PressON/ [ ov | [ o= |

OFF to
switch the P
picture’s 2
animation

Fox

Back to (4 Back |
previous — -
page

I love to chat with friends
in the outdoors -~

p N Press ON/OFF
[I A [ to switch the
picture’s
animation
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Back to < |(i) Back | DOIphln
previous -
page Temperature Setup
Can setup
25.0 (C) 25.0 E a floating
integer
Back_ to < Ki) —ry '
previous —
page
Rare animal Precious Index
(wAET}Y) (BEEE)
G e 67 DOOD
- T 100
= T 90
T 80
T 70
18 —(1)

-50
T4
T30

T 20

T 10

-0

(1) They are two g_B_Inp objects. User can plug one I-8056 card on the PAC Slot 1
to test the DO switches. Setting object to TRUE can enable the picture’s
animation.
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